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This document is a supplement to the “Lab 1.doc” lab exercise that introduces one to the 
basics of ladder logic programming. The following equipment is assumed: 

GE IC695CHS012 12 slot backplane 
GE IC695PSA140 power supply 
GE IC695CPU310 RX3i  processor 
GE IC695ETM001 Ethernet module 
GE IC694MDL660 32 chan. 24v disc. input 
GE IC694MDL754 32 chan. 12/24v disc. out 
 

This document is primarily for Proficy Machine Edition version 9.5. A serial port and an 
Ethernet connection from the PC to the processor is also assumed.  

In order to become familiar with basic ladder logic programming and addressing 
techniques on the PACSystems RX3i equipment, the steps to accomplish the first part of the first 
lab exercise are outlined in sections A, and B.  The remainder of the sections outlines the steps to 
document your ladder, to print the ladder logic program, and to save your ladder logic diagram.  
The last sections explain the differences when programming offline and accessing the 
programming software outside of the laboratory. 

In an industrial setting, the initial PLC programming is done offline and then later 
downloaded to the PLC when ready for the final test and debug.  In addition, there is usually 
only one project (program) for each PLC on the network.  For these labs, the ladder 
programming will be done online so that changes can be immediately tested.    

Proficy Machine Edition version 9.5 is used to program the RX3i PLC's. An icon for this 
program should already be on the desktop. 

The PLC and the PC used to program it are connected directly to the PLC either through 
a serial port or through the Ethernet connection. The serial port must be used to load the initial 
hardware configuration (to set up the Ethernet module) and after that, the Ethernet connection 
may be used.  

For the casual user, the Proficy software is best operated using the point-and-click 
approach.  Towards the top of the screen, buttons for frequently-used commands are displayed in 
toolbars.  One may click on the button, or access the function by selecting commands from the 
menu at the top of the screen. 

 

 
 

A.  STARTING A PROJECT WITH THE RX3i 
 

Make sure the computer, PLC, and external power supply are all powered. 
Start the Proficy programming software by clicking on the PROFICY icon on the 

desktop, or by selecting  
Start | Proficy | Proficy Machine Edition  
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A popup window should appear with a list of selections. If starting a new project:  
Select "Empty Project."  
Click OK.  
On the next window, type in a name for your project in the Project Name field.  
Click OK  
The software will start up in the offline mode and a blank project is displayed.  

If your project is already in the PLC, select your project from the list of projects, and then 
click on OK. Connect to the processor (click on the name of your processor, select "Target" tab 
and click on "Connect"). Double-click on _MAIN in the Inspector window to show the ladder in 
the Editor window.  Skip to the online programming functions. 

When starting a project for the first time, it must initially be set up offline, and then go 
online. The initial setup consists of specifying the processor and configuring the discrete I/O 
modules. 
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Fig. 2. Proficy Machine Edition screen. 
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The PC display (Fig. 2) consists of six windows. On the left one-third of the screen, the 
two panes are the Navigator (top) and Inspector (middle) windows. The Navigator window 
contains the project-related information, such as the PLC configuration and the variable names. 
The two tabs that you will use most are the "Project" (3rd) tab (PLC configuration, program files) 
and "Variables" (4th) tab (variable definitions). The Inspector window displays the properties of 
whatever is highlighted in the Navigator window. The Editor window is the large pane in the 
middle top of the screen. This is where the ladder is displayed. When the "InfoViewer" tab is 
selected, help information is displayed here. The window at the top right of the screen is the 
Toolchest. The LD blocks are selected from the Toolchest, but variable data types can also be 
displayed. The lower left contains the Data Watch window, which displays the values of selected 
variables. The Feedback Zone window is at the lower right and logs the results of compiling the 
program, attempted connection to the PLC, program download, etc. 

When starting Proficy for the first time, the windows will not appear as shown in Fig. 2. 
To set up the windows as shown in Fig. 2, 

Close Feedback Zone window (at bottom) 
Reset view – From main menu, select View. Click on Docking View.  
Add Data Watch – Still in View. Select Data Watch. It will appear at the bottom. Size it 

to fill horizontally if not already that way. 
Add Feedback Zone – Still in View. Select Feedback Zone. It will appear at the bottom, 

about 1/3 of the screen width on the left side. Size the Data Watch Window if not 
already that way. 

Add Toolchest – Still in View. Select Toolchest. It will appear in the right side. You may 
want narrower (so middle window larger). 

 

1. Configuring the Processor 
When starting a project for the first time, check and make sure the Offline/Online 

window in the lower right corner displays "Offline Administrator". Select the "Project" tab of the 
Navigator window (if not already selected). The name of your project should be displayed. To 
configure your processor, do the following: 

Right-mouse your project name in the "Project" tab of the Navigator window. 
Select Add Target | GE Intelligent Platforms Controller | PACSystems RX3i 
Items will be added to the project. The process will end with PROFICY expecting 

you to edit the "Target1" line below your project name. You should change 
"Target1" to your project name (but, you can also leave it alone). 

Expand the Hardware Configuration (Click on the +)  
Expand Rack 0 
Right-mouse the "Slot 0" module and select Replace Module…. Select the 

appropriate power supply (IC695PSA140) and click on OK. 
A configuration window with the module number on the tab may appear in the Editor 

window. To remove this tab, right-click “x” in the upper right of the window 
displaying the power supply properties. 

Right-mouse the "Slot 2" module and select Replace Module…. Select the 
appropriate CPU (IC695CPU310) and click on OK. Answer Yes to the prompt 
about common parameters. A configuration window should appear in the editor 
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window. (If not right-mouse the Slot 2 module and select Configure) Click on the 
“Settings” Tab. Change the Passwords field to “Disabled”. 

Right-mouse "Slot 4" module and select Add Module…. Select the appropriate 
Ethernet module by clicking on the “Communications” tab and select 
IC695ETM001 and click on OK. 

A tab for the new module will appear in the Editor window. Click on the 
“IC695ETM001” tab (if not selected already).  

Set up the Ethernet configuration. Click the "Settings" tab at the top of the Editor 
window. Fill in the following information: 

Use BOOTP: No 
IP Address: whatever IT assigns 
Subnet Mask: whatever IT assigns 
Gateway IP Address: whatever IT assigns 
Name Server IP: whatever IT assigns 
Status Address: %I00001 

To remove the Ethernet window, click on the “x” in the upper right of the 
window. 

The processor is now configured. 

Set up project communications. Select the processor name in the Navigator window 
(second line - next to the gray diamond) and then right click on the processor name and select 
Properties.  
If communicating via the Ethernet port: 

In the Inspector window, scroll down until you see the Physical Port line.  
It should be "ETHERNET". 
Enter the following for the IP Address: whatever you used above 

If communicating with the serial port: 
In the Inspector window, scroll down until you see the Physical Port line.  
It should be "COM1".  
 

You are now ready to configure the I/O channels. 

 
2. I/O Configuration 

Using the Proficy software, configuration of the inputs and outputs involves two steps: 
1. specifying modules in the rack 
2. assigning symbols to the I/O channels 

The second step is not absolutely necessary, but it is easier to specify symbols now than when 
programming the ladder logic.  The Proficy programming software aids the programming of a 
PLC because one does not need to memorize the I/O addresses and file addresses, but can refer 
to them symbolically, as a variable. 

The PLC will be set up so that the module configuration is as follows: 
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Slot Module Description Start Addr. 

0 IC695PSA140 Power Supply  

2 IC695CPU310 CPU  

4 IC695ETM001 Ethernet module %I1 (ENet status) 

5 IC694MDL660 32 channel 24 volt disc. input %I81 

6 IC694MDL754 32 channel 12/24 volt disc. output %Q1 

 
Select the "Project" tab of the Navigator window (if not already selected). The name of 

your project should be displayed. To configure the I/O modules, do the following: 
Expand the Hardware Configuration (Click on the +)  
Expand Rack 0 
Right-mouse "Slot 5" and select Add Module…. Select the "Discrete Input" tab. 

Select the appropriate module (IC694MDL660) and click on OK. 
A configuration window with the module number on the tab will appear in the Editor 

window. Note that the starting address for this modules address is %I81. There is 
no configuration information that needs changing, so remove this module tab by 
clicking on the “x” in the upper corner. 

Right-mouse "Slot 6" and select Add Module…. Select the "Discrete Output" tab. 
Select the appropriate module (IC694MDL754) and click on OK. 

A configuration window with the module number on the tab will appear in the Editor 
window. Note that the starting address for this modules address is %Q1. There is 
no configuration information that needs changing, so remove this module tab by 
clicking on the “x” in the upper corner. 

Now assign variables to the input/output channels. Click on the "Variables" tab in the 
Navigator window. An empty variable list will appear. To define variables and assign to the 
discrete input/output channels, 

Click on the "Variables" tab at the top of the screen. 
Select New icon (first one in toolbar)  and then the data type (BOOL). A variable 

list entry is created with "BOOL" as the name of the new variable. The "BOOL" 
variable will be highlighted and you are expected to change the variable name. 
Change "BOOL" to your symbol name, in this case "Start_PB" and press <Enter>. 
Note: if the BOOL variable is not contained in an edit box, right-mouse the 
variable name and select Rename.  

If the “Ref Address” column is not shown in the Navigator window, click on the icon 
in the upper left corner of the Navigator window (the Property Columns View 
icon).  

Click in the "Ref. Address" column for this variable and change it to %I81 and then 
press <Tab>. 

If the cursor is not in the Description column, use the mouse or cursor keys to move 
the box to the Description column. Type in a description, for example, "Start push 
button switch" and then press <Enter>. Note: you may want to move the left side 
of the Editor window to see the Description column. 
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Once the Navigator window is displaying tags, one can right-click in the window to 
define a new variable. 

Repeat the above steps to specify the variables and descriptions for the other input 
and output channels. 

 
3. Specifying Other Variables 

 
It is good practice to enter all of the variables before you start programming. However, 

Proficy will automatically create the undefined variables when compiling the program.  
You should probably save your project. 

To check that the processor is properly configured, the blank program should be 
downloaded to the processor. 

 
4. Processor Download 

Before downloading the program, it should be verified by selecting from the program 
menu Target | Validate. The errors and warnings are displayed in the Feedback Zone window. 
The Feedback Zone window should indicate 0 errors and 0 warnings. If you defined TON 
variables, you will see some warnings about setting the retentive properties on some of the fields. 
That is okay and you should not see the warnings for these timers again because Proficy fixed 
the problem automatically. 

If using serial port, before downloading through the serial port, make sure RSLinx does 
not control the serial port.  To do this, start RSLinx and click on the blue ‘S’ (configure drivers 
icon).  Then select ABDF1 under “Name and Description”.  If the description for ABDF1 
indicates "Running", then click the Stop button.  The description will then indicate "Stopped." 

To connect to the processor, select from the program menu Target | Connect. The 
progress is displayed in the Feedback Zone. If successful, "Connected to the device" is 
displayed. 

Now go online with the processor by clicking on the Programmer Mode icon toward the 
left side of icon bar. You should see a green diamond on the bottom right of the screen with a red 
“X” on top of it. If "Stop" does not appear after the green diamond, click on the icon with the 
black square to stop the processor. 

If the "Stop" icon is red, stop the processor by clicking on the "Stop" icon. At prompt, 
check that the "Outputs Disabled" is checked and then click on OK. 

To download the program, click on the Download icon. A window will be displayed 
asking which parts of the project to download. The "Hardware Configuration" should be checked 
only if downloading for the first time you are downloading the program. Subsequent times, it 
should be unchecked in order to save time. The download progress is displayed in the Feedback 
Zone. If the name of the project is different, then answer Yes to the prompt about overwriting the 
name. If successful, "Connected to device" is displayed. 
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If a message indicating a fault is displayed, click on Diagnostics in the icon bar. A fault 
table is displayed. The "Loc" column indicates the module with the error, 0.x, where "x" is the 
slot number. A description of the fault is in the next column. Click on the fault row to display 
detailed information. A "System configuration mismatch" description means an incorrect module 
in the slot. To clear the fault table, click on "Clear Controller Fault Table" on the left side of the 
table below the "Sort Order" box. Correct the error. You will probably need to disconnect from 
the controller to correct the error. 

You are now on-line, indicated by the green diamond at the bottom of the screen. Skip to 
the online editing functions. 

For your information, to download and start the program, select from the Target menu 
Download (and download) and then Start  

 
 

B. LADDER LOGIC PROGRAMMING 
 
The box at the bottom of the screen should show "Stop" after the green diamond.  The 

steps necessary to program the first part of the exercise, the series rung, will be explained in 
detail.  For the other parts of the exercise, only the different steps required to do these parts are 
explained. 

To show the ladder program in the Editor window, expand Logic in the Navigator 
window, expand Program Blocks, and double-click on _MAIN. The ladder logic window is 
marked off in rectangles, whose corners are indicated by the dots. Contact and coil instructions 
occupy one rectangle. Timer instructions occupy two or three (vertically stacked) rectangles. 
Counter instructions occupy three rectangles. Math instructions occupy at least three rectangles, 
depending on the number of inputs. The position of the cursor is indicated by the gray rectangle.  
 
1. Two Contacts in Series (Logical AND)   

The first ladder program to be implemented will be a simple series control rung.  Two 
switches, SW3 and SW4, will be placed in series and will be used to control a single light, LA1. 

 
To put in the contacts and coil, do the following:   

A normally open (NO) relay contact is needed at the input, so click on the NO contact 
in the toolbar above the ladder window. Now move the cursor to the upper left 
ladder logic position and click. A “Logic Change Options” window will appear. 
Click on the “Lose logic equality” option and then click on OK. A pink contact 
appears, connected to the left power rail. (Pink indicates that you are editing the 
program on-line and that you have not downloaded the program changes to the 
PLC.)  

An alternate way to select the NO contact is to select it from the Toolchest by 
expanding the Contacts folder. Select the appropriate contact symbol (-| |- 
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NOCON) and holding down the left-mouse button, drag the gray rectangle to the 
upper left ladder logic position and release the mouse button.  

Add another NO contact to the next position right of the other contact. 
Add the output coil by clicking on the coil icon above the ladder window and then 

click on the position directly right of the two contacts. It will be actually placed in 
the tenth column. Alternatively, a coil can be selected from the toolchest Coils 
folder as -( )- COIL. 

Click on the Pointer icon (arrow to left of NO contact) to exit the component 
placement mode. 

Double-click on the first contact and a window will popup, asking for the address or 
variable of the contact. 

Switch SW3 will be used first, so type the variable or address for that switch ("SW3" 
or "%I83") and press <Enter>.  The variable that controls the contact will appear 
above the contact symbol on the ladder diagram. Alternatively, if you have 
forgotten the variable name, select the variable from the displayed list. 

Double-click on the other NO contact. Type the symbol or address for that switch 
("SW4" or "%I84") and press <Enter>.  

Double-click on the output coil and type the symbol or address for light LA1 ("LA1" 
or "%Q1"). 

 

The green diamond at the bottom of the window should have a red "X" on top of it and 
"Logic NE" should show in the window to the right of the green diamond. In order to run this 
program, the changes must be downloaded into the PLC. The changes you just made were not 
actually entered into the PLC memory. Click on the Download icon (green arrow beneath a paper 
sheet) and then the Run icon (right-pointing triangle). If a “Start Controller” window pops up, 
select “Outputs Enabled” and then OK. The right box along the bottom of the window should 
show a green diamond and "Logic EQ". 

Try the input switches in various combinations and observe the output.  Also observe the 
changing status of ladder components on the screen.  Energized or true conditions cause the 
elements to be highlighted (green) on the ladder diagram. Note that if SW3 is off, and SW4 is on, 
the second contact does not highlight, but the “SW4” changes to green to indicate that the switch 
is on, even though power is not flowing through the contact, due to SW3 being open.  

 
2.  Entering Branches (Logical OR)  

Stop the controller to change the processor back to program mode:  
Click on the Stop icon (black square), select "Outputs Disabled" and then click on 

OK.  
The SW4 contact is deleted and then added to the row below the contact for SW3. To 

place the SW4 contact in parallel with the SW3 contact, 
Delete the SW4 contact by selecting it (gray rectangle around it) and pressing the 

<Del> key. A “Logic Change Options” window will appear. Click on the “Lose 
logic equality” option and then click on OK. 
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Now, click on the Horiz/Vert Wire icon (“T” rotated CCW 90 degrees). Move the 
cursor into the ladder. Notice that as you move the cursor, it indicates a vertical or 
horizontal line. Move it to the blank spot. It should change to a horizontal line. 
Click the mouse to the "fill in" the place where the contact was deleted. 

Move the cursor below and to the right of the SW3 contact. It should change to a 
vertical line. Click the mouse and a vertical branch is added below SW3. 

Add a NO contact to the ladder position beneath the SW3 contact. Select the Pointer 
icon. Double-click the new contact and type "SW4" to add the variable to it. 

 
Download the program and start the processor. The controller is now set to respond to 

input conditions and perform appropriate output commands. 
Note: to make on-line changes and download the processor, it is not necessary to stop the 

processor. If you download the processor while it is running, you will be asked if you really want 
to do the download, but you will not be forced to stop the processor. 
 
 
3.  Timers 

A timer occupies two or three (vertically stacked) rectangles on the screen. To place a 
timer block in a network: 

Expand the Timers folder in the Toolchest to show the available timer function 
blocks. The timer resolution is indicated by the block name suffix. Note that 
_SEC is not supported by the RX3i processors. (The timer icon located just after 
the -(R)- coil icon is a retentive on-delay timer.) 

Drag-and-drop the appropriate timer (TMR_...) to the ladder window. Note that they 
cannot be placed in the first column. The cursor will change to a circle with a 
diagonal if you are trying to place a block in an illegal location. 

Double-click on the "????" field in the timer block. Type the timer variable name in 
the popup window. If the timer variable does not exist, it will be created for you. 

Place the logic for the timer input (top input connection). 
To specify the preset (PV) input, double-click on the blank space just to the left of the 

PV input. Either type in the preset value as an integer, or specify an integer 
variable that contains the preset value. 

 
When downloading the changed program, if you created a new timer variable, a pop-up 

will appear. The “Cleared” option should be selected and then click on OK. 
As the program is executing, the timer accumulator value is shown as a number just 

above the timer variable in the timer block. The timer values can also be viewed in the Data 
Watch window as follows: 

<name>[0] Accumulator 
<name>[1] Preset 
<name>[2] Control word 
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4.  Counters 
A counter occupies three (vertically stacked) rectangles on the screen. To place a counter 

block in a network: 
Expand the "Counters" folder in the Toolchest to show the available counter function 

blocks. Alternatively, the up and down counter icons are located just left of the 
horiz/vertical wire icon. 

Drag-and-drop the appropriate counter to the ladder window. Note that they cannot be 
placed in the first column. The cursor will change to a circle with a diagonal if 
you are trying to place a block in an illegal location. 

Double-click on the "????" field in the counter block. Type the counter variable name 
in the popup window. 

Place the logic for the counter input (top input connection) and the reset (R) input. 
To specify the preset (PV) input, double-click on the blank space just to the left of the 

PV input. Either type in the preset value as an integer, or specify an integer 
variable that contains the preset value. 

 

As the program is executing, the counter accumulator value is shown as a number just 
above the counter variable in the counter block. The counter values can also be viewed in the 
Data Watch window as follows: 

<name>[0] Accumulator 
<name>[1] Preset 
<name>[2] Control word 

 
5.  Online Editing With PLC in Run Mode 

The ladder logic program may be edited while the PLC is in the Run mode. Proficy 
actually has two modes of on-line editing. If an edit to the program is started while on-line, the 
user is presented with a pop-up window with two choices: 

Enter Test Edit Mode 
Lose Logic Equality 

If one selects, “Lose Logic Equality”, the editing is essentially done off-line and then 
downloaded to the processor. If one selects “Enter Test Edit Mode”, then the editing is done on-
line.   

In Test Edit Mode, a few more steps are required, since edited rungs are not immediately 
executed. The process of Test Edit Mode editing is illustrated by Figure 2. After rungs are edited, 
they must be tested and then “assembled” before the process is complete. If the edits are 
discovered to be unacceptable while in the Test Edit mode, the test may be cancelled and then 
modify the edits of the edits may be cancelled. 

While in the Test Edit Mode, purple lightening bolts appear in the margins. The type of 
editing on a particular rung is indicated in the left margin: 

(Del) – being deleted 
(Ins) – new rung 
(Mod) – modifying an existing rung 
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While editing, the new rungs are not being executed, shown as a white background. While 
testing edits, the new/modified rungs are shown with a light blue background. The old or deleted 
rungs are shown with a darker gray background, indicated they are being skipped.  

To test the new rungs, right click on the ladder and select Debug | Test Edits. While 
testing edits, the new/modified rungs are shown with a light blue background. The old or deleted 
rungs are shown with a darker gray background, indicated they are being skipped. 

If the program operation with the new rungs is acceptable, then right click on the ladder 
and select Debug | Accept Edits. When the rungs are assembled, the old rungs are deleted from 
the PLC memory and the edit zone markers are removed. 

If the new rungs are unacceptable, either while editing or during testing, right click on the 
ladder and select Debug | Cancel Edit. One is presented with a popup with three options: 

Restore original logic in editor – complete cancel the edits 
Keep modified logic in editor – keeps modified rungs, going back to essentially off-line 

editing. 
Stay in Test Edit mode – returns to Test Edit mode 

 
Begin

Edit Session

Select "Test Edit Mode"

Online
Edits

Edits complete, checked
Right-click -   | Debug Begin Test

Test
Edits

Program operation acceptable
Right-click -   | Debug Accept Edits

Edits
Assembled

End
Edit Session

Program operation unacceptable
Right-click -   | Debug Cancel Test

Accept without testing
Right-click -   | Debug Accept Edits

Want to discard edits
Right-click -   | Debug Cancel Edit

Cancel
Edit Session

Want to discard edits
Right-click -   | Debug Cancel Edit

 
 

Fig. 2. Test Edit Mode steps. 
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C. ADDING COMMENTS TO LADDER PROGRAM 
 
To insert a comment, put the cursor anywhere along the top row of a rung. From the main 

menu, select Insert | Comment. A row is inserted and blank comment box appears in this new 
row. Click inside the comment box and type your comment. When finished, click outside the 
comment box. 

 

D. DEFINING VARIABLES AND/OR ASSIGNING TO ADDRESSES 
For a large project, it is much easier to enter the symbols into an external file in the 

format of comma separated variables and import them into the database.  However, for the 
purposes of this lab, it is probably easier to manipulate the database directly. There are times 
when one will want to assign a specific address to a variable, or to correct an incorrectly entered 
variable. 

To define or change variables, click on the "Variables" tab in the Navigator window. The 
variable list will appear. To define a new variable, 

Right-click on the "Variable List" line. 
Select New Variable  and then the appropriate data type. A variable list entry is 

created with the data type as the name of the new variable. The data type name 
will be highlighted and you are expected to change the variable name. Change to 
your variable name.  

If the variable should be attached to a physical I/O channel, the address should be 
placed in the “Ref Address” column. If the “Ref Address” column is not shown, 
click on the icon in the upper left corner of the Navigator window (the Property 
Columns View icon). Click in the "Ref. Address" column for the variable and 
change it to the appropriate address. 

Enter an appropriate description in the Description column. Note: you may want to 
move the left side of the Navigator window to see the Description column. 

   
To modify the variable name and/or description for an address, use the mouse or cursor 

keys to highlight the appropriate box and type in the correct information. To move to another 
field, use the mouse to select another field.   

To delete a symbol from the database, use the mouse or cursor keys to highlight the 
variable name in the record. Press the <Del> key. A confirmation popup appears. Click on OK. 

 

E. DISPLAYING VARIABLE VALUES 
 
Variables are displayed in the Data Watch window. Double-click on a blank entry in the 

“Variable Name” column and type in the name of the variable. 
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To change the value of an internal variable in the data watch table, double-click in the 
“Value” column. Now change the value. For Boolean variables, one can also right-click in the 
“Value” column and select “Turn On” or ‘Turn Off”. 
 

F. INPUT/OUTPUT FORCING 
 
For inputs, the force function allows one to override the actual status of external inputs by 

forcing individual discrete inputs to be ON or OFF. Input forces are written to the input image 
table and have no effect on the actual input.  The value in the force table overrides the actual 
input.  For example, if %I83 is forced to 1 (ON), it will appear in the input image and ladder 
logic as 1, regardless of the actual status of the device. 

For outputs, the force function allows one to override the processor logic and force 
individual discrete outputs to be ON or OFF.  Output forces are written directly to the output 
device and do not appear in the output image table. The value in the force table overrides the 
value in the output image.  For example, if %Q2 is forced to 1 (ON), the actual output will be 
ON, regardless of how it appears in the ladder and output image table. 
 

Note: Enabling or disabling forces can result in sudden machine movement, possibly injuring 
personnel.  Applying of removing forces while forces are enabled takes place immediately, 
with no prompt for confirmation. USE EXTREME CAUTION WHEN USING FORCES! 

 
When the cursor is on a contact controlled by a physical discrete input, forcing functions 

are accessed by right-clicking the mouse. The forcing functions are: 
Force ON Forces the physical input on. 
Force OFF Forces the physical input off. 
Remove Force Removes the forcing. 

A forced input is indicated by the underlined red symbol/address. 
 

 

G. IMPORTING/EXPORTING   
 

1. Importing Database from CSV File 
One must be offline to import variables. 
To import an address/tag/description database from a .CSV (comma-separated variable) 
file: 

Right-click on the top line in the "Variables" tab in the Navigator window). 
Select Import. 
A pop up will ask to specify certain import options. The defaults should work in most 

situations. The options are as follows: 
Identify variable conflict 
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By variable name – when name of variable in import file matches the 
name of a variable already in the data base. 

By variable address and data type– when name of variable and data type in 
import file matches the name and data type of a variable already in the 
data base. 

If there is a conflict 
Keep existing variable properties – new variable(s) will not be imported. 
Overwrite existing variable properties – new variable(s) will replace 

existing in project. 
Rename imported variable – new variable(s) name will be suffixed with a 

two-digit number and then added to the project data base. 
Click on Next> 
An window will open to allow one to select which variable to import. To import all, 

click on All >>  
Click on Next> 
On the next screen review the selection and the click on Finish. 
The variables are imported. 

 
 
2. Exporting Database to CSV File 

To export a variable database to a .CSV (comma-separated variable) file: 
Right-click on the top line in the "Variables" tab in the Navigator window). 
Select Export. 
An export window will open. Select folder for file to be placed. Name destination 

file. 
Click on Save. 

 
Note that individual variables may be exported, also.  

 
 
 
H. SAVING LADDER LOGIC PROGRAMS   

Ladder logic programs (projects) are automatically saved to the default program directory 
on the hard disk. One then saves the program to a flash drive for backup/transport to another 
computer. 

The default directory where programs are saved is  
C:\Program Files\CIMPLICITY Machine Edition\SecurWORX\Local\FrameworX 

To change the default directory where programs are saved, 
Close the open project 
In the Navigator window, click on the “Options” tab and select Machine Edition | 

Preferences.  
In the Inspector window, scroll down to the “Project Files Location”. 
Change the directory. 
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To best way to save a project that will be moved to another computer is to backup the 

project,  
Close the open project 
In the Navigator window, click on the “Manager” tab. 
Right-click on your project, and select Back Up...  
A backup window will open. Select folder for file to be placed. Name destination file. 
Click on Save. 

 
 

 
 

 

I. RESTORING LADDER LOGIC PROGRAMS  
 
Restore a previously backed-up project file with the following steps: 

Close any open projects. 
In the Navigator window, click on the “Manager” tab. 
Right-click on the “My Computer” line, and select Restore...  
A restore window will open. Select folder and file of the project archive (.zip) file. 
Click on Open. 
If the project by this name already exists on the computer, a pop-up will appear. 

Select either “Rename” or “Overwrite” as appropriate. 
The project is now loaded into the PC 

 

 

J. PRINTING A LADDER LOGIC PROGRAM 
 
You may print your program only while disconnected from the PLC (off-line).  
 
Set ladder view options to “full comment” 
 Select first tab in Navigator window 
 Select Editors | Ladder | View 
 In inspector window, set comment mode to “Full” 
 
To print program, 
 Right-mouse Program Blocks 

Select Print LD Blocks 
Select appropriate blocks 
Select “Print rung comments” and “Full- entire comment” 
Do not select “Show variable cross reference between rungs” 
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Do not select “Shrink to fit” 
 
To print variable list, 
 From main menu, select Variables | Report 

Select “All variables by name” 
Click on “Print” 
Print-out appears in an InfoViewer window. 
Select File | Print 
Prints on default printer. 

 


